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Respiration 
(© Susan Matthews and Graeme Lindbeck) 

 
Objectives 

1. To describe oxidation and reduction in terms of electron and H+ transfer. 
2. To distinguish anaerobic from aerobic cellular respiration in terms of ATP, oxygen, and 

chemiosmosis. 
3. To demonstrate that carbon dioxide is a product of cell respiration. 
4. To determine the effect of boiling on the aerobic respiration of bean seeds and explain the result in 

terms of enzyme activity. 
5. To measure the rate of oxygen consumption in germinating bean seeds. 
6. To determine the metabolic rates for several small animals and relate this to body size and 

lifestyle. 
 

Introduction 
All organisms, whether plant or animal, bacteria, protists or fungi, carry out cellular respiration. During 
respiration organic food molecules are oxidized and these exergonic oxidation reactions are coupled with 
the synthesis of ATP, an endergonic reaction. The ATP is then used to drive the metabolic reactions 
necessary to maintain the organism’s physical integrity and to support all its other activities. 
 
The cytoplasm of all cells contains the enzymes needed in the ancient central pathway of glycolysis, in 
which glucose is oxidized to pyruvate in the absence of oxygen. The energy released in this process is used 
to generate ATP directly by substrate level phosphorylation, in which phosphate groups are transferred 
directly from organic substrates to ADP. 
 
To obtain energy from glucose, hydrogen atoms are removed from the glucose molecule as it is 
metabolized. These hydrogen atoms can be removed only by hydrogen (electron) carriers, such as NAD+. 
Cells contain a finite amount of NAD+ and since each NAD+ combines with only two hydrogens 
(electrons), there must be a mechanism for removing the hydrogens (electrons) from NADH so that 
glycolysis can continue.  
 
In many organisms, respiration can occur under anaerobic conditions where no oxygen is present. Many 
bacteria, yeast, and animals ferment glucose, producing lactate or ethanol. During fermentation reactions, 
hydrogens are removed from glucose, passed to the electron carrier NAD+ (forming NADH), and then on to 
pyruvic acid (the end product of glycolysis), converting it to lactate or ethanol. Concurrently, the NADH is 
oxidized to NAD+, reconstituting the NAD+ pool required for glycolysis. Fermentation allows cells to make 
ATP in the absence of oxygen. Cells metabolizing glucose by fermentation harvest only about 5% of the 
available energy in glucose, however. 
 
Most organisms use molecular oxygen in a process called cellular respiration. In this series of reactions, the 
glucose molecule is completely disassembled to yield CO2 and H2O. The process begins with glycolysis; 
the end product of glycolysis, pyruvate, enters the mitochondrion where it is further metabolized. 
 
After entering the mitochondrion, the pyruvate loses a CO2 molecule to form acetyl CoA, which enters a 
series of reactions known as the Kreb’s cycle or citric acid cycle where it is completely oxidized to CO2. 
The electrons released during this series of reactions are used to reduce NAD+, and a related molecule 
FAD, to NADH and FADH2, respectively. These electron carriers then transfer their electrons to the 
electron transport chain (ETC), a series of proteins embedded in the inner membrane of the mitochondrion. 
The passage of electrons through the ETC generates an H+ gradient across the inner membrane which 
drives the synthesis of ATP by ATP synthetases embedded in the inner membrane. The last electron carrier 
protein in the ETC transfers the electrons to molecular oxygen to form water, with the addition of H+. This 
transfer of electrons to oxygen returns the protein (cytochrome oxidase) to its oxidized state so that it can 
continue to accept electrons from the remainder of the ETC. 
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The process of cellular respiration can be summarized by the following equation: 
 
C6H12O6   +   6O2      →      6CO2   +   6H2O   +   ATP 
Glucose      Oxygen        Carbon      Water        Energy 
                                        dioxide 
Complete respiration of one molecule of glucose results in a yield of 30-32 ATP molecules. Four of these 
ATP’s are the product of substrate-level phosphorylation; the remaining ATP’s are synthesized by the ATP 
synthetases using the energy of the H+ gradient created by electrons passing down the ETC in a process 
called oxidative phosphorylation. The coupling of electron flow with ATP synthesis is described in the 
chemiosmotic model. 
 
Overall, 16 times more ATP is produced by aerobic respiration than by anaerobic respiration. Even so, less 
than 50% (the actual number is about 39%) of the available energy in a glucose molecule is actually stored 
in ATP molecules. In contrast, fermentation and anaerobic respiration yield only two ATP’s. This is equal 
to only about 2% of the available energy in glucose. Clearly aerobic respiration gives a bigger energy 
payback than anaerobic respiration. 
 
In today’s lab you will be carrying out a series of experiments that will demonstrate several aspects of 
respiration including the release of carbon dioxide as a product of respiration, the uptake of oxygen by 
organisms during aerobic respiration, and attempt to demonstrate that metabolic rate (the rate of oxygen 
usage per gram of body weight) is a function of animal size. 
 
Safety Precautions: 

1. Gloves must been worn while handling the chemicals used in the lab today. Gloves must be placed 
in the biohazard bucket when finished 

2. The germinated, ungerminated and boiled germinated seeds must be placed in the appropriately 
labelled containers at the end of the experiments. 

3. Phenol red solutions must be placed in the hazardous waste container. 
 
 
Carbon Dioxide Production 
Seeds contain stored food material in the form of some carbohydrate. When a seed germinates, the 
carbohydrate is broken down, liberating energy (ATP) needed for growth of the enclosed embryo into a 
seedling. 
 
Two days ago, a set of dry bean seeds was soaked in water to start the germination process. Another set 
was not soaked. This experiment will compare carbon dioxide production between germinating bean seeds, 
germinating bean seeds that have been boiled, and ungerminated (dry) bean seeds. 
 
Procedure: 

1. Obtain three respiration flask setups. One of these flasks will already contain ungerminated bean 
seeds and have the rubber stopper with attached fixtures already inserted.  

2. Fill one of the remaining flasks with germinated seeds to the same level as the flask of 
ungerminated seeds. Fill the remaining flask with boiled germinated seeds to the same level. 

3. Fit the rubber stoppers securely into the two flasks you filled. Add enough water to each test tube 
to cover the ends of the glass tubes coming out of the respiration flasks. 

4. Set the flasks aside for about 1½ hours while you complete the remaining experiments. 
5. After about 1½ hours, replace the water in each test tube with phenol red solution. Phenol red is a 

pH indicator, that is, it changes color in response to changes in pH. The stock solution is red (pH 
neutral), but in the presence of an acid the solution turns yellow. When CO2 is bubbled through 
water it forms a mild acid called carbonic acid 

6. Pour water through the thistle funnel into each flask to force the gases through the glass tubing and 
into the phenol red solution.  

7. Record your results in table 1 and use these results to answer the questions below. 
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Table 1. CO2 Production 
 
 Germinating bean seeds Boiled germinating bean 

seeds 
Ungerminated bean seeds 

Color  
 

  

CO2 Present  
 

  

  
1. Which set of seeds was undergoing respiration? 

 
 
 
 
 

2. What happened during boiling that caused the results you found? (Hint: Think about the effect 
of boiling on the enzymes) 

 
 
 
 
 
 
Oxygen Uptake by Germinating Beans 
The equation for cellular respiration indicates that oxygen is consumed and carbon dioxide is given off. The 
uptake of oxygen is evidence that cellular respiration is occurring. The uptake of oxygen and the parallel 
release of carbon dioxide can be monitored using gas sensors and plotted as a function of time. In this 
experiment you will examine respiration rates for both ungerminated and germinated kidney bean seeds. 
 
Procedure: 

1. Line the bottom of the chamber with two layers of paper towel. 
2. Count out 200 ungerminated seeds and add these to the chamber. 
3. Insert the two gas sensor probes into the lid of the chamber (if not already done) and place the lid 

securely on the chamber. 
4. Connect the O2 probe to port #1 and the CO2 probe to port #2. The data logger will automatically 

recognize each probe and open a reading window for each. 
5. Tap on the O2 window and change the units to ppm (parts per million). Do the same for the CO2 

probe. 
6. Change the data collection parameters to one sample every 5 seconds for 600 seconds, if not 

already set. 
7. Wait five minutes for the readings to stabilize then begin data collection by tapping the green 

arrow at the bottom of the screen. 
8. Tap the “Graph” tab and select “Autoscale once”. The data logger will now automatically adjust 

the plot scale during the 10 minutes of data collection, stopping collection at the end of 10 
minutes. 

9. Tap on the “Analyze” tab from the top menu followed by “Curve Fit”, select the O2 graph and 
“Linear Regression”.  Record the value for m (the slope of the regression line and therefore the 
rate of O2 uptake) in the appropriate box in the table below. Repeat for the CO2 graph. 

10. Store your data at the end of the run by tapping on the filing cabinet icon. The graph plots will be 
automatically reset for the next run once the data have been saved. 
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11. Remove the ungerminated seeds, placing them in the appropriate container. CO2 is heavier than air 
- invert the chamber to remove any residual gas. 

12. Lightly dampen the paper towel in the chamber and add 200 germinated seeds. 
13. Repeat steps 7-9 for the germinated seeds. 
14. Remove the germinated seeds, placing them in the appropriate container, and clean and dry the 

chamber. CO2 is heavier than air - invert the chamber to remove any residual gas. 

You must print your results from the bean experiments before continuing on to the next part of 
the lab. Failure to do so may result in the loss of your data. 
 
15. Tap on the “Run 2” icon and select “All Runs”. The graphs for the ungerminated and germinated 

seeds will now be displayed on a common set of axes ready for printing. 
16. Confirm that your data logger is connected to the HP laser printer in the lab (tap on the wi-fi icon 

in the bottom right-hand corner to see the available connections and the current connection). 
17. To print the currently displayed graph, tap on the “File” tab in the top menu, select “Print” then 

“Graph”. You will have an opportunity to add a label to your graph before it is printed. Make sure 
to print copies for every member of your group.  

Table 2. O2 uptake and CO2 output of ungerminated and germinated bean seeds 
 

Beans 
O2 

Rate of consumption 
(ppm/sec) 

CO2 
Rate of respiration 

(ppm/sec) 
Ungerminated seeds 

 
  

Germinated seeds 
 

  

 
Answer the following questions using the data from the table and your knowledge of respiration. 

1. Do you have evidence that cell respiration occurred in beans? Explain. 

 
 
 
 
 
 

2. How do the respiratory rates for germinating and non-germinating seeds compare? 
 
 
 
 
 
 
 
 
 

3. How do you account for this difference? 
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4. The gas sensors measure gas concentration in units of parts per million, or ppm. In gaseous 
mixtures, 1 part per million refers to 1 part by volume in 1 million volume units of the whole. A 
concentration of 100 ppm for O2 would simply mean that there are 100 L of O2 gas for every 
1,000,000 L of air (or 0.1 mL of O2 per 1 L of air). Multiply the rate of O2 uptake for the 
germinating seeds by 60 to convert this to ppm/minute. If it takes about 820ml of oxygen to 
completely oxidize 1g of glucose, how much glucose are your germinating beans consuming 
during one hour? The volume of the chamber is 2000ml or 2 liters. 

 
 
 
 
 
 
 
 
 
The Metabolic Rate of Earthworms 
The amount of oxygen used or carbon dioxide produced by the respiration of animals is one measure of all 
the organic processes going on within the animal. The term metabolism is sometimes used to describe this 
sum total of all life processes. 
 
There are many factors that influence the metabolic rate of an animal. Some of these are physical activity, 
diet, general state of health, and hormones such as those secreted by the thyroid gland and the adrenal 
cortex. The metabolic rate of an animal is also influenced by whether the animal is warm-blooded or cold-
blooded. Warm-blooded animals (homeotherms), which have the ability to maintain a relatively constant 
internal temperature, have a fairly uniform rate of metabolism. Cold-blooded animals (poikilotherms), 
whose internal body temperature is determined by their surroundings, have a metabolism that is determined 
by their surroundings. 
 
Even apparently simple animals such as earthworms are capable of significant rates of respiration. These 
animals are members of a group called annelid, or segmented, worms. While simple in appearance, these 
worms have many of the same organ systems as more complex animals, including a complete digestive 
tract, a nervous system (including a simple “brain”), a closed circulatory system (with five hearts!), and 
excretory system. In this investigation, you will determine the metabolic rate of earthworms using a 
volumeter setup similar to the one you used for the bean seeds above. 
 
Procedure: 

1. Line the bottom of the chamber with a double layer of lightly dampened paper towels. 
2. Obtain 15 nightcrawlers and rinse them gently with water to remove any dirt. Record the 

weight of the worms in the table below then place them in the chamber.  
3. Insert the two gas sensor probes into the lid of the chamber (if not already done) and place the 

lid securely on the chamber. 
4. Connect the O2 probe to port #1 and the CO2 probe to port #2. The data logger will 

automatically recognize each probe and open a reading window for each. 
5. Tap on the O2 window and change the units to ppm (parts per million). Do the same for the 

CO2 probe. 
6. Change the data collection parameters to one sample every 5 seconds for 600 seconds, if not 

already set. 
7. Wait five minutes for the readings to stabilize then begin data collection by tapping the green 

arrow at the bottom of the screen. 
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8. Tap the “Graph” tab and select “Autoscale once”. The data logger will now automatically 
adjust the plot scale during the 10 minutes of data collection, stopping collection at the end of 
10 minutes. 

9. Tap on the “Analyze” tab from the top menu followed by “Curve Fit”, select the O2 graph and 
“Linear Regression”.  Record the value for m (the slope of the regression line and therefore 
the rate of O2 uptake) in the appropriate box in the table below. Repeat for the CO2 graph. 

10. Return the earthworms to their container and clean and dry the chamber. 
11. Confirm that your data logger is connected to the HP laser printer in the lab (tap on the wi-fi 

icon in the bottom right-hand corner to see the available connections and the current 
connection). 

12. To print the currently displayed graph, tap on the “File” tab in the top menu, select “Print” 
then “Graph”. You will have an opportunity to add a label to your graph before it is printed. 
Make sure to print copies for every member of your group.  

Table 3. Metabolic rate of earthworms 
 
 Total weight of 

earthworm’s in 
grams  

 

 
Rate of O2 uptake 

(ppm/sec) 

 
Rate of respiration 

(ml O2/min) 

Metabolic rate 
(ml O2/min/g body 

weight) 

Earthworms 
 

    

 
Refer to the previous experiment for the technique for converting ppm/sec to ml/min and complete the 
calculation of the metabolic rate for the earthworms. 
 
Answer the following questions using the data from the table and your knowledge of respiration. 

1. This experiment was carried out at room temperature (about 20oC). If the same experiment was 
carried out at a higher or lower temperature, what change (if any) would you expect to observe in 
metabolic rate? 

 
 
 
 
 
 
 

2. Most animals that we are familiar with carryout gas exchange by respiration (breathing in and 
out). Earthworms must also carryout gas exchange. How do you think this is carried out? Is there 
anything you can observe about the earthworms that supports your idea? 

 
 


